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PROGRAM ARDUINO 

 

#include <SoftwareSerial.h> 

 

SoftwareSerial mySerial(2, 3); 

String number = "085268675474"; 

//String number = "08990739348"; 

 

int sensorPin = A0; 

int sensorValue = 0; 

int sensor_api = A1; 

int sensor_suhu = A3; 

int api_value = 0; 

int suhu_value = 0; 

int tempC=0; 

 

void setup() 

{ 

  mySerial.begin(9600);   // Setting Sim900 Serial  

  Serial.begin(9600);    // Setting the baud rate of Serial Monitor 

  (Arduino) 

  analogReference(DEFAULT); 

  pinMode(8,OUTPUT); 

  pinMode(9,OUTPUT); 

  delay(100); 

  mySerial.println("AT"); 

  digitalWrite(8,HIGH); 

  digitalWrite(9,HIGH); 

 

  pinMode(10,OUTPUT);   //buzzer 

  digitalWrite(10,LOW); 

} 

 

 

void loop() 

{ 

  sensor(); 

  if(sensorValue>350 || api_value <200 ){ 

    digitalWrite(8,LOW); 

    digitalWrite(9,LOW); 

    SendMessage(); 

    Serial.println("SMS OK"); 

    do { 

      sensor(); 



      digitalWrite(10,HIGH);  

    } 

    while(sensorValue>350 || api_value <200 ); 

    delay(2000);  

    digitalWrite(10,LOW); 

    Serial.println("SELESAI"); 

    //SendMessage(); 

  } 

  else if(tempC>70){ 

    digitalWrite(8,LOW); 

    digitalWrite(9,LOW); 

    SendMessage(); 

    Serial.println("SMS OK"); 

    do { 

      sensor(); 

      digitalWrite(10,HIGH);  

    } 

    while(tempC>70); 

    delay(2000);  

    digitalWrite(10,LOW); 

    Serial.println("SELESAI"); 

    //SendMessage(); 

  } 

  else{ 

    sensor(); 

    digitalWrite(8,HIGH); 

    digitalWrite(9,HIGH); 

    digitalWrite(10,LOW); 

    } 

   

  if (Serial.available()>0) 

  switch(Serial.read()) 

  { 

    case 'a': 

      mySerial.println("AT"); 

      break; 

    case 's': 

      SendMessage(); 

      break; 

    case 'r': 

      RecieveMessage(); 

      break; 

  } 

 

  String buffer = readSIM900A(); 

  if (buffer.startsWith("\r\n+CMT: ")) 



    { 

      Serial.println("*** RECEIVED A SMS ***"); 

      // Remove first 51 characters 

      buffer.remove(0, 51); 

      int len = buffer.length(); 

      // Remove \r\n from tail 

      buffer.remove(len - 2, 2); 

       

      if (buffer == "Cek"){ 

        SendMessage(); 

//        digitalWrite(3,LOW); 

//        delay(1000); 

//        digitalWrite(3,HIGH); 

      } 

      Serial.println(buffer); 

      Serial.println("*** END SMS ***"); 

    } 

} 

 

void sensor() 

{ 

  suhu_value = analogRead(sensor_suhu); 

  tempC = suhu_value * 0.488; 

//  Serial.print("temp= "); 

  Serial.print(tempC); 

   Serial.print(" , "); 

//  delay(500); 

   

  sensorValue = analogRead(sensorPin); 

  api_value = analogRead(sensor_api); 

  Serial.print(sensorValue); Serial.print(" , "); 

  Serial.println(api_value); 

} 

 

void SendMessage() 

{ 

  mySerial.println("AT+CMGF=1");    //Sets the GSM Module in 

  Text Mode 

  delay(500);  // Delay of 1000 milli seconds or 1 second 

  mySerial.println("AT+CMGS=\"" +number+ "\"\r"); // Replace x 

  with mobile number 

  delay(500); 

  mySerial.println("Awas Bahaya!!! Terdeteksi Adanya Api dan 

  Asap");// The SMS text you want to send 

  delay(100); 

   mySerial.println((char)26);// ASCII code of CTRL+Z 



  delay(500); 

} 

 

void RecieveMessage() 

{ 

  mySerial.println("AT+CNMI=2,2,0,0,0"); // AT Command to 

  receive a live SMS 

  delay(1000); 

 } 

 

String readSIM900A() 

{ 

    String buffer; 

    while (mySerial.available()) 

    { 

      char c = mySerial.read(); 

      buffer.concat(c); 

      delay(10); 

    } 

    return buffer; 

} 

 



The  Arduino  Uno  is  a  microcontroller  board  based  on  the  ATmega328  (datasheet).  It  has  14  digital 
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a 
USB connection,  a power jack,  an ICSP header,  and a reset  button.  It  contains everything needed to 
support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC 
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI 
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version 
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB 
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions, 
see the index of Arduino boards.

http://arduino.cc/en/Main/Boards
http://www.atmel.com/dyn/resources/prod_documents/doc8161.pdf


EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf

Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/O Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA

Flash Memory 32 KB of which 0.5 KB used by 
bootloader

SRAM 2 KB 
EEPROM 1 KB 
Clock Speed 16 MHz



The Arduino Uno can be powered via the USB connection or with an external power supply. The power  
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter 
can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a 
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V 
pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage 
regulator may overheat and damage the board.  The recommended range is 7 to 12 volts.

The power pins are as follows: 

• VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 
5 volts from the USB connection or other regulated power source). You can supply voltage through 
this pin, or, if supplying voltage via the power jack, access it through this pin. 

• 5V. The regulated power supply used to power the microcontroller and other components on the 
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another 
regulated 5V supply. 

• 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA. 
• GND. Ground pins. 

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootloader); It  
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(), and 
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and 
has an internal  pull-up resistor  (disconnected by default)  of  20-50 kOhms.  In  addition,  some pins have 
specialized functions: 

• Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are 
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip . 

• External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a 
rising or falling edge, or a change in value. See the attachInterrupt() function for details. 

• PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function. 
• SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which, 

although provided by the underlying hardware, is not currently included in the Arduino language. 

• LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is  
on, when the pin is LOW, it's off. 

http://arduino.cc/en/Reference/AnalogWrite
http://arduino.cc/en/Reference/AttachInterrupt
http://arduino.cc/en/Reference/DigitalRead
http://arduino.cc/en/Reference/DigitalWrite
http://arduino.cc/en/Reference/PinMode
http://www.arduino.cc/en/Reference/EEPROM


The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By  
default they measure from ground to 5 volts, though is it possible to change the upper end of their range 
using  the  AREF  pin  and  the  analogReference()  function.  Additionally,  some  pins  have  specialized 
functionality: 

• I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wire library. 

There are a couple of other pins on the board: 

• AREF. Reference voltage for the analog inputs. Used with analogReference(). 
• Reset. Bring this line LOW to reset  the microcontroller.  Typically  used to add a reset  button to 

shields which block the one on the board. 

See also the mapping between Arduino pins and Atmega328 ports. 

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other 
microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on 
digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB 
and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB 
COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the 
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins. 

The  ATmega328 also support  I2C (TWI) and SPI communication. The Arduino software includes a Wire 
library to simplify use of the  I2C bus; see the  documentation for details. To use the SPI communication, 
please see the ATmega328 datasheet. 

The  Arduino  Uno  can  be  programmed  with  the  Arduino  software  (download).  Select  "Arduino  Uno  w/ 
ATmega328" from the  Tools > Board menu (according to the microcontroller on your board). For details,  
see the reference and tutorials. 

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code 
to  it  without  the use of  an external  hardware  programmer.  It  communicates  using the original  STK500 
protocol (reference, C header files). 

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial 
Programming) header; see these instructions for details. 

The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU bootloader,  
which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and  
then resetting the 8U2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac 
OS X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer 
(overwriting the DFU bootloader). 

http://dfu-programmer.sourceforge.net/
http://www.atmel.com/dyn/products/tools_card.asp?tool_id=3886
http://dev.arduino.cc/wiki/uno/Hacking/Programmer
http://www.atmel.com/dyn/resources/prod_documents/avr061.zip
http://www.atmel.com/dyn/resources/prod_documents/doc2525.pdf
http://arduino.cc/en/Tutorial/Bootloader
http://arduino.cc/en/Tutorial/HomePage
http://arduino.cc/en/Reference/HomePage
http://arduino.cc/en/Main/Software
http://arduino.cc/en/Reference/Wire
http://www.arduino.cc/en/Reference/SoftwareSerial
http://arduino.cc/en/Hacking/PinMapping168
http://arduino.cc/en/Reference/AnalogReference
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Reference/AnalogReference


Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a  
way that allows it to be reset by software running on a connected computer. One of the hardware flow control  
lines (DTR)  of  the ATmega8U2 is  connected to  the reset  line of  the ATmega328 via  a  100 nanofarad 
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The 
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the  
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR 
can be well-coordinated with the start of the upload. 

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or 
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or 
so, the bootloader is running on the  Uno. While it is programmed to ignore malformed data (i.e. anything 
besides  an  upload  of  new code),  it  will  intercept  the  first  few bytes  of  data  sent  to  the board  after  a  
connection is opened. If a sketch running on the board receives one-time configuration or other data when it  
first  starts,  make sure  that  the  software  with  which  it  communicates  waits  a  second after  opening the  
connection and before sending this data. 

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can  
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset 
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details. 

The  Arduino  Uno has  a  resettable  polyfuse  that  protects  your  computer's  USB ports  from shorts  and 
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer 
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection 
until the short or overload is removed. 

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector 
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to 
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple 
of the 100 mil spacing of the other pins. 

http://www.arduino.cc/cgi-bin/yabb2/YaBB.pl?num=1213719666/all


Arduino can sense the environment by receiving input from a variety of sensors and can affect its 
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is 
programmed  using  the  Arduino  programming  language (based  on  Wiring)  and  the  Arduino 
development environment (based on Processing). Arduino projects can be stand-alone or they can 
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You’ll have to follow different instructions for your personal 
OS. Check on the Arduino site for the latest instructions.  http://arduino.cc/en/Guide/HomePage

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Now you’re actually ready to “burn” your 
first  program on the arduino board. To 
select “blink led”, the physical translation 
of  the  well  known  programming  “hello 
world”, select

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

Once you have your skecth you’ll 
see something very close to the 
screenshot on the right. 

In Tools>Board select

Now you have to go to
Tools>SerialPort 
and select the right serial port, the 
one arduino is attached to.

http://arduino.cc/en/Guide/HomePage
http://www.processing.org/
http://wiring.org.co/
http://arduino.cc/en/Reference/HomePage




1.      Warranties 

1.1     The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The 
producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,  
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects that result from 
Customer's design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems 
necessary.

1.2     If any  products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The producer's liability 
shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the 
producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period.

1.3     EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER DISCLAIMS ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

1.4     Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the 
products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other 
services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth 
above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5     The Arduino products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause 
severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the 
operation of nuclear facilities and weapons systems. Arduino products are neither designed nor intended for use in military or aerospace applications or 
environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino products which  is solely 
at the Customer's risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its 
products and any use of Arduino products in Customer's applications, notwithstanding any applications-related information or support that may be 
provided by the producer.

2.       Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages,  
liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this 
terms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

3.        Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or  
exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the 
possibility of such damages. This section will survive the termination of the warranty period.

4.      Changes to specifications

The producer  may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or 
characteristics of any features or instructions marked "reserved" or "undefined." The producer reserves these for future definition and shall have no 
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is 
subject to change without notice. Do not finalize a design with this information.

The producer of Arduino  has joined the Impatto Zero® 
policy of LifeGate.it. For each Arduino board produced is 
created / looked after half  squared Km of Costa Rica’s 
forest’s.



    

 

MQ-2  Semiconductor Sensor for Combustible Gas  

Sensitive material of MQ-2 gas sensor is SnO2, which with lower conductivity in clean air. When the 
target combustible gas exist, The sensor’s conductivity is more higher along with the gas concentration 
rising. Please use simple electrocircuit, Convert change of conductivity to correspond output signal of 
gas concentration. 

MQ-2 gas sensor has high sensitity to LPG, Propane and Hydrogen, also could be used to Methane 
and other combustible steam, it is with low cost and suitable for different application. 

Character                                            Configuration                                   

*Good sensitivity to Combustible gas in wide range                                                   
* High sensitivity to LPG, Propane and Hydrogen                                       
* Long life and low cost                                            
* Simple drive circuit 

Application                         

* Domestic gas leakage detector 
* Industrial Combustible gas detector 
* Portable gas detector 
 
 
 
Technical Data                                      Basic test loop 

T

The above is basic test circuit of the sensor. 

The sensor need to be put 2 voltage, 

heater voltage（VH） and test voltage（VC）. 

VH used to supply certified working 

temperature to the sensor, while VC used 

to detect voltage (VRL) on load resistance

（RL）whom is in series with sensor. The 

sensor has light polarity, Vc need DC 

power. VC and VH could use same power 

circuit with precondition to assure 

performance of sensor. In order to make 

the sensor with better performance, 

suitable RL value is needed: 

Power of Sensitivity body(Ps): 

Ps=Vc2×Rs/(Rs+RL)2 

Model No. MQ-2 

Sensor Type Semiconductor  

Standard Encapsulation Bakelite (Black Bakelite) 

Detection Gas  Combustible gas and smoke

Concentration 
300-10000ppm 

( Combustible gas) 

Loop Voltage Vc ≤24V  DC 

Heater Voltage VH 5.0V±0.2V ACorDC 
Circuit 

Load 

Resistance 
RL Adjustable 

Heater 

Resistance 
RH 31Ω±3Ω（Room Tem.） 

Heater 

consumption 
PH ≤900mW 

Sensing 

Resistance 
Rs 2KΩ-20KΩ(in 2000ppm C3H8 )

Sensitivity S 
Rs(in air)/Rs(1000ppm  

isobutane)≥5 

Character 

Slope α ≤0.6(R5000ppm/R3000ppm CH4) 

Tem.  Humidity 20℃±2℃；65%±5%RH 

Standard test circuit 
Vc:5.0V±0.1V； 

  VH: 5.0V±0.1V 
Condition 

Preheat time Over 48 hours 

Vc

VH 

GND

RL 

VRL 
 



    

 

Resistance of sensor(Rs): Rs=(Vc/VRL-1)×RL 

 

                                                                                    
Sensitivity Characteristics                          Influence of Temperature/Humidity 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.1 shows the typical sensitivity characteristics of                 Fig.2 shows the typical temperature and humidity 

the MQ-2, ordinate means resistance ratio of the sensor             characteristics. Ordinate means resistance ratio 

(Rs/Ro), abscissa is concentration of gases. Rs means           of the sensor (Rs/Ro), Rs means resistance of sensor 

resistance in different gases, Ro means resistance of           in 1000ppm Butane under different tem. and humidity. 

sensor in 1000ppm Hyrogen. All test are under standard         Ro means resistance of the sensor in environment of 

test conditions.                                              1000ppm Methane, 20℃/65%RH                              

 
Structure and configuration 

 

Structure and configuration of MQ-2 gas sensor is shown as Fig. 3, sensor composed by micro AL2O3 ceramic tube, Tin 

Dioxide (SnO2) sensitive layer, measuring electrode and heater are fixed into a crust made by plastic and stainless steel 

net. The heater provides necessary work conditions for work of sensitive components. The enveloped MQ-2 have 6 pin, 4 

of them are used to fetch signals, and other 2 are used for providing heating current. 
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Notification 
1 Following conditions must be prohibited 
1.1 Exposed to organic silicon steam                 

Organic silicon steam cause sensors invalid, sensors must be avoid exposing to silicon bond, 
fixature, silicon latex, putty or plastic contain silicon environment 
1.2 High Corrosive gas 

If the sensors exposed to high concentration corrosive gas (such as H2Sz, SOX，Cl2，HCl etc), it will 
not only result in corrosion of sensors structure, also it cause sincere sensitivity attenuation.  
1.3 Alkali, Alkali metals salt, halogen pollution 

  The sensors performance will be changed badly if sensors be sprayed polluted by alkali metals salt 
especially brine, or be exposed to halogen such as fluorin.   
1.4 Touch water 

  Sensitivity of the sensors will be reduced when spattered or dipped in water.                  
1.5 Freezing      

  Do avoid icing on sensor’surface, otherwise sensor would lose sensitivity.        
1.6 Applied voltage higher  

Applied voltage on sensor should not be higher than stipulated value, otherwise it cause down-line or 
heater damaged, and bring on sensors’ sensitivity characteristic changed badly.  
1.7 Voltage on wrong pins  

For 6 pins sensor, if apply voltage on 1、3 pins or 4、6 pins, it 
will make lead broken, and without signal when apply on 2、4 pins  
 
2 Following conditions must be avoided 
2.1 Water Condensation  

 Indoor conditions, slight water condensation will effect sensors performance lightly. However, if water 
condensation on sensors surface and keep a certain period, sensor’ sensitivity  will be decreased. 

  
2.2 Used in high gas concentration   

  No matter the sensor is electrified or not, if long time placed in high gas concentration, if will affect 
sensors characteristic.     

                                                         
2.3 Long time storage 

  The sensors resistance produce reversible drift if it’s stored for long time without electrify, this drift is 
related with storage conditions. Sensors should be stored in airproof without silicon gel bag with clean air. 
For the sensors with long time storage but no electrify, they need long aging time for stbility before using.  

 
2.4 Long time exposed to adverse environment 

 No matter the sensors electrified or not, if exposed to adverse environment for long time, such as 
high humidity, high temperature, or high pollution etc, it will effect the sensors performance badly.  

 
2.5 Vibration 

Continual vibration will result in sensors down-lead response then repture. In transportation or 
assembling line, pneumatic screwdriver/ultrasonic welding machine can lead this vibration.  

 
2.6 Concussion  

If sensors meet strong concussion, it may lead its lead wire disconnected.  
 

2.7 Usage  
For sensor, handmade welding is optimal way. If use wave crest welding should meet the following 

conditions:  
2.7.1  Soldering flux: Rosin soldering flux contains least chlorine 
2.7.2  Speed: 1-2 Meter/ Minute  
2.7.3  Warm-up temperature：100±20℃  
2.7.4  Welding temperature：250±10℃  
2.7.5  1 time pass wave crest welding machine 

If disobey the above using terms, sensors sensitivity will be reduced.  

 



Flame Sensor Module

Introduction
This module is sensitive to the flame and radiation. It also can detect 
ordinary light source in the range of of a wavelength 760nm-1100 nm. The 
detection distance is up to 100 cm.

The Flame sensor can output digital or analog signal. It can be used as a 
flame alarm or in fire fighting robots. 

 Future Electronics Egypt Ltd. (Arduino Egypt).

http://store.fut-electronics.com/11ASENS-FL-001.html
http://store.fut-electronics.com/11ASENS-FL-001.html
http://store.fut-electronics.com/index.php
http://store.fut-electronics.com/index.php


Description

• Detects a flame or a light source of a wavelength in the range of 
760nm-1100 nm

• Detection distance: 20cm (4.8V) ~ 100cm (1V)
• Detection angle about 60 degrees, it is sensitive to the flame spectrum.
• Comparator chip LM393 makes module readings stable.
• Adjustable detection range.
• Operating voltage 3.3V-5V
• Digital and Analog Output 
  " DO digital switch outputs (0 and 1)
  " AO analog voltage output

• Power indicator and digital switch output indicator

Interface Description (4-wire)
1) VCC -- 3.3V-5V voltage
2) GND -- GND
3) DO  -- board digital output interface (0 and 1)
4) AO  -- board analog output interface

 Future Electronics Egypt Ltd. (Arduino Egypt).

http://store.fut-electronics.com/index.php
http://store.fut-electronics.com/index.php


Arduino Example

Here is sample code and connection to Arduino board. The analog 
output can be connected to any analog input pin on Arduino.

AnalogReadSerial
  Reads an analog input on pin 0, prints the result to the serial monitor.
  Attach the center pin of a potentiometer to pin A0, and the outside pins to 
+5V and ground.
 
 This example code is in the public domain.
 */

// the setup routine runs once when you press reset:
void setup() {
  // initialize serial communication at 9600 bits per second:
  Serial.begin(9600);
}

// the loop routine runs over and over again forever:
void loop() {
  // read the input on analog pin 0:
  int sensorValue = analogRead(A0);
  // print out the value you read:
  Serial.println(sensorValue);
  delay(1);        // delay in between reads for stability
}

 Future Electronics Egypt Ltd. (Arduino Egypt).

http://store.fut-electronics.com/index.php
http://store.fut-electronics.com/index.php


LM35
Precision Centigrade Temperature Sensors
General Description
The LM35 series are precision integrated-circuit temperature
sensors, whose output voltage is linearly proportional to the
Celsius (Centigrade) temperature. The LM35 thus has an
advantage over linear temperature sensors calibrated in
˚ Kelvin, as the user is not required to subtract a large
constant voltage from its output to obtain convenient Centi-
grade scaling. The LM35 does not require any external
calibration or trimming to provide typical accuracies of ±1⁄4˚C
at room temperature and ±3⁄4˚C over a full −55 to +150˚C
temperature range. Low cost is assured by trimming and
calibration at the wafer level. The LM35’s low output imped-
ance, linear output, and precise inherent calibration make
interfacing to readout or control circuitry especially easy. It
can be used with single power supplies, or with plus and
minus supplies. As it draws only 60 µA from its supply, it has
very low self-heating, less than 0.1˚C in still air. The LM35 is
rated to operate over a −55˚ to +150˚C temperature range,
while the LM35C is rated for a −40˚ to +110˚C range (−10˚
with improved accuracy). The LM35 series is available pack-

aged in hermetic TO-46 transistor packages, while the
LM35C, LM35CA, and LM35D are also available in the
plastic TO-92 transistor package. The LM35D is also avail-
able in an 8-lead surface mount small outline package and a
plastic TO-220 package.

Features
n Calibrated directly in ˚ Celsius (Centigrade)
n Linear + 10.0 mV/˚C scale factor
n 0.5˚C accuracy guaranteeable (at +25˚C)
n Rated for full −55˚ to +150˚C range
n Suitable for remote applications
n Low cost due to wafer-level trimming
n Operates from 4 to 30 volts
n Less than 60 µA current drain
n Low self-heating, 0.08˚C in still air
n Nonlinearity only ±1⁄4˚C typical
n Low impedance output, 0.1 Ω for 1 mA load

Typical Applications

DS005516-3

FIGURE 1. Basic Centigrade Temperature Sensor
(+2˚C to +150˚C)

DS005516-4

Choose R1 = −VS/50 µA
V OUT=+1,500 mV at +150˚C

= +250 mV at +25˚C
= −550 mV at −55˚C

FIGURE 2. Full-Range Centigrade Temperature Sensor
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Connection Diagrams

TO-46
Metal Can Package*

DS005516-1

*Case is connected to negative pin (GND)

Order Number LM35H, LM35AH, LM35CH, LM35CAH or
LM35DH

See NS Package Number H03H

TO-92
Plastic Package

DS005516-2

Order Number LM35CZ,
LM35CAZ or LM35DZ

See NS Package Number Z03A

SO-8
Small Outline Molded Package

DS005516-21

N.C. = No Connection

Top View
Order Number LM35DM

See NS Package Number M08A

TO-220
Plastic Package*

DS005516-24

*Tab is connected to the negative pin (GND).
Note: The LM35DT pinout is different than the discontinued LM35DP.

Order Number LM35DT
See NS Package Number TA03F

LM
35
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Absolute Maximum Ratings (Note 10)

If Military/Aerospace specified devices are required,
please contact the National Semiconductor Sales Office/
Distributors for availability and specifications.

Supply Voltage +35V to −0.2V
Output Voltage +6V to −1.0V
Output Current 10 mA
Storage Temp.;

TO-46 Package, −60˚C to +180˚C
TO-92 Package, −60˚C to +150˚C
SO-8 Package, −65˚C to +150˚C
TO-220 Package, −65˚C to +150˚C

Lead Temp.:
TO-46 Package,

(Soldering, 10 seconds) 300˚C

TO-92 and TO-220 Package,
(Soldering, 10 seconds) 260˚C

SO Package (Note 12)
Vapor Phase (60 seconds) 215˚C
Infrared (15 seconds) 220˚C

ESD Susceptibility (Note 11) 2500V
Specified Operating Temperature Range: TMIN to T MAX
(Note 2)

LM35, LM35A −55˚C to +150˚C
LM35C, LM35CA −40˚C to +110˚C
LM35D 0˚C to +100˚C

Electrical Characteristics
(Notes 1, 6)

LM35A LM35CA

Parameter Conditions Tested Design Tested Design Units

Typical Limit Limit Typical Limit Limit (Max.)

(Note 4) (Note 5) (Note 4) (Note 5)

Accuracy T A=+25˚C ±0.2 ±0.5 ±0.2 ±0.5 ˚C

(Note 7) T A=−10˚C ±0.3 ±0.3 ±1.0 ˚C

T A=TMAX ±0.4 ±1.0 ±0.4 ±1.0 ˚C

T A=TMIN ±0.4 ±1.0 ±0.4 ±1.5 ˚C

Nonlinearity T MIN≤TA≤TMAX ±0.18 ±0.35 ±0.15 ±0.3 ˚C

(Note 8)

Sensor Gain T MIN≤TA≤TMAX +10.0 +9.9, +10.0 +9.9, mV/˚C

(Average Slope) +10.1 +10.1

Load Regulation T A=+25˚C ±0.4 ±1.0 ±0.4 ±1.0 mV/mA

(Note 3) 0≤IL≤1 mA T MIN≤TA≤TMAX ±0.5 ±3.0 ±0.5 ±3.0 mV/mA

Line Regulation T A=+25˚C ±0.01 ±0.05 ±0.01 ±0.05 mV/V

(Note 3) 4V≤V S≤30V ±0.02 ±0.1 ±0.02 ±0.1 mV/V

Quiescent Current V S=+5V, +25˚C 56 67 56 67 µA

(Note 9) V S=+5V 105 131 91 114 µA

V S=+30V, +25˚C 56.2 68 56.2 68 µA

V S=+30V 105.5 133 91.5 116 µA

Change of 4V≤VS≤30V, +25˚C 0.2 1.0 0.2 1.0 µA

Quiescent Current 4V≤V S≤30V 0.5 2.0 0.5 2.0 µA

(Note 3)

Temperature +0.39 +0.5 +0.39 +0.5 µA/˚C

Coefficient of

Quiescent Current

Minimum Temperature In circuit of +1.5 +2.0 +1.5 +2.0 ˚C

for Rated Accuracy Figure 1, IL=0

Long Term Stability T J=TMAX, for ±0.08 ±0.08 ˚C

1000 hours

LM
35
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Electrical Characteristics
(Notes 1, 6)

LM35 LM35C, LM35D

Parameter Conditions Tested Design Tested Design Units

Typical Limit Limit Typical Limit Limit (Max.)

(Note 4) (Note 5) (Note 4) (Note 5)

Accuracy, T A=+25˚C ±0.4 ±1.0 ±0.4 ±1.0 ˚C

LM35, LM35C T A=−10˚C ±0.5 ±0.5 ±1.5 ˚C

(Note 7) T A=TMAX ±0.8 ±1.5 ±0.8 ±1.5 ˚C

T A=TMIN ±0.8 ±1.5 ±0.8 ±2.0 ˚C

Accuracy, LM35D
(Note 7)

T A=+25˚C ±0.6 ±1.5 ˚C

TA=TMAX ±0.9 ±2.0 ˚C

TA=TMIN ±0.9 ±2.0 ˚C

Nonlinearity T MIN≤TA≤TMAX ±0.3 ±0.5 ±0.2 ±0.5 ˚C

(Note 8)

Sensor Gain T MIN≤TA≤TMAX +10.0 +9.8, +10.0 +9.8, mV/˚C

(Average Slope) +10.2 +10.2

Load Regulation T A=+25˚C ±0.4 ±2.0 ±0.4 ±2.0 mV/mA

(Note 3) 0≤IL≤1 mA T MIN≤TA≤TMAX ±0.5 ±5.0 ±0.5 ±5.0 mV/mA

Line Regulation T A=+25˚C ±0.01 ±0.1 ±0.01 ±0.1 mV/V

(Note 3) 4V≤V S≤30V ±0.02 ±0.2 ±0.02 ±0.2 mV/V

Quiescent Current V S=+5V, +25˚C 56 80 56 80 µA

(Note 9) V S=+5V 105 158 91 138 µA

V S=+30V, +25˚C 56.2 82 56.2 82 µA

V S=+30V 105.5 161 91.5 141 µA

Change of 4V≤VS≤30V, +25˚C 0.2 2.0 0.2 2.0 µA

Quiescent Current 4V≤V S≤30V 0.5 3.0 0.5 3.0 µA

(Note 3)

Temperature +0.39 +0.7 +0.39 +0.7 µA/˚C

Coefficient of

Quiescent Current

Minimum Temperature In circuit of +1.5 +2.0 +1.5 +2.0 ˚C

for Rated Accuracy Figure 1, IL=0

Long Term Stability T J=TMAX, for ±0.08 ±0.08 ˚C

1000 hours

Note 1: Unless otherwise noted, these specifications apply: −55˚C≤TJ≤+150˚C for the LM35 and LM35A; −40˚≤TJ≤+110˚C for the LM35C and LM35CA; and
0˚≤TJ≤+100˚C for the LM35D. VS=+5Vdc and ILOAD=50 µA, in the circuit of Figure 2. These specifications also apply from +2˚C to TMAX in the circuit of Figure 1.
Specifications in boldface apply over the full rated temperature range.

Note 2: Thermal resistance of the TO-46 package is 400˚C/W, junction to ambient, and 24˚C/W junction to case. Thermal resistance of the TO-92 package is
180˚C/W junction to ambient. Thermal resistance of the small outline molded package is 220˚C/W junction to ambient. Thermal resistance of the TO-220 package
is 90˚C/W junction to ambient. For additional thermal resistance information see table in the Applications section.

Note 3: Regulation is measured at constant junction temperature, using pulse testing with a low duty cycle. Changes in output due to heating effects can be
computed by multiplying the internal dissipation by the thermal resistance.

Note 4: Tested Limits are guaranteed and 100% tested in production.

Note 5: Design Limits are guaranteed (but not 100% production tested) over the indicated temperature and supply voltage ranges. These limits are not used to
calculate outgoing quality levels.

Note 6: Specifications in boldface apply over the full rated temperature range.

Note 7: Accuracy is defined as the error between the output voltage and 10mv/˚C times the device’s case temperature, at specified conditions of voltage, current,
and temperature (expressed in ˚C).

Note 8: Nonlinearity is defined as the deviation of the output-voltage-versus-temperature curve from the best-fit straight line, over the device’s rated temperature
range.

Note 9: Quiescent current is defined in the circuit of Figure 1.

Note 10: Absolute Maximum Ratings indicate limits beyond which damage to the device may occur. DC and AC electrical specifications do not apply when operating
the device beyond its rated operating conditions. See Note 1.

Note 11: Human body model, 100 pF discharged through a 1.5 kΩ resistor.

Note 12: See AN-450 “Surface Mounting Methods and Their Effect on Product Reliability” or the section titled “Surface Mount” found in a current National
Semiconductor Linear Data Book for other methods of soldering surface mount devices.

LM
35
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Typical Performance Characteristics

Thermal Resistance
Junction to Air

DS005516-25

Thermal Time Constant

DS005516-26

Thermal Response
in Still Air

DS005516-27

Thermal Response in
Stirred Oil Bath

DS005516-28

Minimum Supply
Voltage vs. Temperature

DS005516-29

Quiescent Current
vs. Temperature
(In Circuit of Figure 1.)

DS005516-30

Quiescent Current
vs. Temperature
(In Circuit of Figure 2.)

DS005516-31

Accuracy vs. Temperature
(Guaranteed)

DS005516-32

Accuracy vs. Temperature
(Guaranteed)

DS005516-33

LM
35

www.national.com5



Typical Performance Characteristics (Continued)

Applications
The LM35 can be applied easily in the same way as other
integrated-circuit temperature sensors. It can be glued or
cemented to a surface and its temperature will be within
about 0.01˚C of the surface temperature.

This presumes that the ambient air temperature is almost the
same as the surface temperature; if the air temperature were
much higher or lower than the surface temperature, the
actual temperature of the LM35 die would be at an interme-
diate temperature between the surface temperature and the
air temperature. This is expecially true for the TO-92 plastic
package, where the copper leads are the principal thermal
path to carry heat into the device, so its temperature might
be closer to the air temperature than to the surface tempera-
ture.

To minimize this problem, be sure that the wiring to the
LM35, as it leaves the device, is held at the same tempera-
ture as the surface of interest. The easiest way to do this is
to cover up these wires with a bead of epoxy which will
insure that the leads and wires are all at the same tempera-
ture as the surface, and that the LM35 die’s temperature will
not be affected by the air temperature.

The TO-46 metal package can also be soldered to a metal
surface or pipe without damage. Of course, in that case the
V− terminal of the circuit will be grounded to that metal.
Alternatively, the LM35 can be mounted inside a sealed-end
metal tube, and can then be dipped into a bath or screwed
into a threaded hole in a tank. As with any IC, the LM35 and
accompanying wiring and circuits must be kept insulated and
dry, to avoid leakage and corrosion. This is especially true if
the circuit may operate at cold temperatures where conden-
sation can occur. Printed-circuit coatings and varnishes such
as Humiseal and epoxy paints or dips are often used to
insure that moisture cannot corrode the LM35 or its connec-
tions.

These devices are sometimes soldered to a small
light-weight heat fin, to decrease the thermal time constant
and speed up the response in slowly-moving air. On the
other hand, a small thermal mass may be added to the
sensor, to give the steadiest reading despite small deviations
in the air temperature.

Temperature Rise of LM35 Due To Self-heating (Thermal Resistance, θJA)
TO-46, TO-46*, TO-92, TO-92**, SO-8 SO-8** TO-220

no heat
sink

small heat fin no heat
sink

small heat fin no heat
sink

small heat fin no heat
sink

Still air 400˚C/W 100˚C/W 180˚C/W 140˚C/W 220˚C/W 110˚C/W 90˚C/W

Moving air 100˚C/W 40˚C/W 90˚C/W 70˚C/W 105˚C/W 90˚C/W 26˚C/W

Still oil 100˚C/W 40˚C/W 90˚C/W 70˚C/W

Stirred oil 50˚C/W 30˚C/W 45˚C/W 40˚C/W

(Clamped to metal,

Infinite heat sink) (24˚C/W) (55˚C/W)

*Wakefield type 201, or 1" disc of 0.020" sheet brass, soldered to case, or similar.
**TO-92 and SO-8 packages glued and leads soldered to 1" square of 1/16" printed circuit board with 2 oz. foil or similar.

Noise Voltage

DS005516-34

Start-Up Response

DS005516-35

LM
35
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Typical Applications

CAPACITIVE LOADS

Like most micropower circuits, the LM35 has a limited ability
to drive heavy capacitive loads. The LM35 by itself is able to
drive 50 pf without special precautions. If heavier loads are
anticipated, it is easy to isolate or decouple the load with a
resistor; see Figure 3. Or you can improve the tolerance of
capacitance with a series R-C damper from output to
ground; see Figure 4.

When the LM35 is applied with a 200Ω load resistor as
shown in Figure 5, Figure 6 or Figure 8 it is relatively immune
to wiring capacitance because the capacitance forms a by-
pass from ground to input, not on the output. However, as
with any linear circuit connected to wires in a hostile envi-
ronment, its performance can be affected adversely by in-
tense electromagnetic sources such as relays, radio trans-
mitters, motors with arcing brushes, SCR transients, etc, as
its wiring can act as a receiving antenna and its internal
junctions can act as rectifiers. For best results in such cases,
a bypass capacitor from VIN to ground and a series R-C
damper such as 75Ω in series with 0.2 or 1 µF from output to
ground are often useful. These are shown in Figure 13,
Figure 14, and Figure 16.

DS005516-19

FIGURE 3. LM35 with Decoupling from Capacitive Load

DS005516-20

FIGURE 4. LM35 with R-C Damper

DS005516-5

FIGURE 5. Two-Wire Remote Temperature Sensor
(Grounded Sensor)

DS005516-6

FIGURE 6. Two-Wire Remote Temperature Sensor
(Output Referred to Ground)

DS005516-7

FIGURE 7. Temperature Sensor, Single Supply, −55˚ to
+150˚C

DS005516-8

FIGURE 8. Two-Wire Remote Temperature Sensor
(Output Referred to Ground)

DS005516-9

FIGURE 9. 4-To-20 mA Current Source (0˚C to +100˚C)

LM
35
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Typical Applications (Continued)

DS005516-10

FIGURE 10. Fahrenheit Thermometer

DS005516-11

FIGURE 11. Centigrade Thermometer (Analog Meter)

DS005516-12

FIGURE 12. Fahrenheit ThermometerExpanded Scale
Thermometer

(50˚ to 80˚ Fahrenheit, for Example Shown)

DS005516-13

FIGURE 13. Temperature To Digital Converter (Serial Output) (+128˚C Full Scale)

DS005516-14

FIGURE 14. Temperature To Digital Converter (Parallel TRI-STATE ™ Outputs for
Standard Data Bus to µP Interface) (128˚C Full Scale)

LM
35
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Typical Applications (Continued)

DS005516-16

*=1% or 2% film resistor
Trim RB for VB=3.075V
Trim RC for VC=1.955V
Trim RA for VA=0.075V + 100mV/˚C x Tambient
Example, VA=2.275V at 22˚C

FIGURE 15. Bar-Graph Temperature Display (Dot Mode)

DS005516-15

FIGURE 16. LM35 With Voltage-To-Frequency Converter And Isolated Output
(2˚C to +150˚C; 20 Hz to 1500 Hz)

LM
35

www.national.com9



Block Diagram

DS005516-23

LM
35
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Physical Dimensions inches (millimeters) unless otherwise noted

TO-46 Metal Can Package (H)
Order Number LM35H, LM35AH, LM35CH,

LM35CAH, or LM35DH
NS Package Number H03H

SO-8 Molded Small Outline Package (M)
Order Number LM35DM

NS Package Number M08A

LM
35
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Physical Dimensions inches (millimeters) unless otherwise noted (Continued)

Power Package TO-220 (T)
Order Number LM35DT

NS Package Number TA03F

LM
35
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Physical Dimensions inches (millimeters) unless otherwise noted (Continued)

LIFE SUPPORT POLICY

NATIONAL’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE SUPPORT
DEVICES OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF THE PRESIDENT AND GENERAL
COUNSEL OF NATIONAL SEMICONDUCTOR CORPORATION. As used herein:

1. Life support devices or systems are devices or
systems which, (a) are intended for surgical implant
into the body, or (b) support or sustain life, and
whose failure to perform when properly used in
accordance with instructions for use provided in the
labeling, can be reasonably expected to result in a
significant injury to the user.

2. A critical component is any component of a life
support device or system whose failure to perform
can be reasonably expected to cause the failure of
the life support device or system, or to affect its
safety or effectiveness.

National Semiconductor
Corporation
Americas
Tel: 1-800-272-9959
Fax: 1-800-737-7018
Email: support@nsc.com

National Semiconductor
Europe

Fax: +49 (0) 180-530 85 86
Email: europe.support@nsc.com

Deutsch Tel: +49 (0) 69 9508 6208
English Tel: +44 (0) 870 24 0 2171
Français Tel: +33 (0) 1 41 91 8790

National Semiconductor
Asia Pacific Customer
Response Group
Tel: 65-2544466
Fax: 65-2504466
Email: ap.support@nsc.com

National Semiconductor
Japan Ltd.
Tel: 81-3-5639-7560
Fax: 81-3-5639-7507

www.national.com

TO-92 Plastic Package (Z)
Order Number LM35CZ, LM35CAZ or LM35DZ

NS Package Number Z03A
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National does not assume any responsibility for use of any circuitry described, no circuit patent licenses are implied and National reserves the right at any time without notice to change said circuitry and specifications.


